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การใช้งาน NodeMCU เบื้องตน้ 

มารู้จัก NodeMCU Dev Kit V1.0 

     NodeMCU นั้นเป็น open-source hardware and firmware ซึ่งเป็นบอร์ดที่ช่วยให้เราสามารถใช้งาน
เกี่ยวกับ IoT (Internet of Thing) ได้อย่างง่าย เพราะการเขียนโปรแกรมต่าง ๆ ควบคุม GPIO ของชิพ ทีใ่ช้ภาษา 
Lua ในการเขียน script เพียงไม่ก่ีบรรทัด หรือใช้ C ก็ได้เช่นกัน 

โดยเป็นโมดูลที่ประกอบด้วย ESP8266-12E มีเสาอากาศแบบ PCB Antenna และรองรับรูปแบบการ
สื่อสารส าหรับขาสัญญาณต่าง ๆ หลาย ๆ ชนิดได้แก่ GPIO, PWM, I2C, 1-wire, ADC และ มี SPI เพ่ิมขี้นมาจาก 
Version เดิม ในการสื่อสารกับ Computer ส่วนของ USB-to-TTL และพอร์ต micro USB ใช้ชิพ USB to Serial 
ของ Silicon Lab CP2102 สิ่งที่จ าเป็นคือเราต้องรู้รูปแบบการจัดวางขาสัญญาณต่าง ๆ ตามรูป 
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Features ของ NodeMCU  
- Open-source 

- สามารถเขียนโปรแกรมสั่งควบคุมได้ 

- ใช้ต้นทุนต่ า 

- ใช้งานง่าย 

- เชื่อมต่อ Wi-Fi ได้ 

- Smart 

- Interactive 

 

สามารถควบคุม hardware I/O เหมือนกับ Arduino 

     มี API ส าหรับการควบคุม I/O ของ Hardware ซึ่งจะช่วยลดการท างานที่ซ้ าซ้อนส าหรับการก าหนดค่า
และจัดการพวก Hardware สามารถเขียนโปรแกรมเช่นเดียวกับ Arduino ได้  

เป็นอุปกรณ์ WiFi ที่ใช้ต้นทุนต่่า 

          ต้นทุนน้อยกว่า 2 ดอลลาร์ NodeMCU WiFi MCU ESP8266 ตัวนี้ผลิตออกมาได้ครบวงจร สามารถ
พัฒนาต่อได้ง่ายในงาน IoT และต้นทุนต่ า ตอนนี้ขายประมาณ 400 บาท 

Specification ของบอร์ด 

     เป็นชุดพัฒนาที่เป็น Base on ESP8266  มี GPIO, PWM , I2C , 1-Wire และ ADC รวมทั้งหมดในบอร์ด
เดียว เป็นช่องทางที่ช่วยในการพัฒนาที่รวดเร็วด้วย NodeMCU firmware! 

-    USB-TTL included, plug&play (CP2102) 

-    ESP-12E 32 Mbps 

-    10 GPIO, ทุก ๆ GPIO สามารถเป็น PWM, I2C, 1-wire 

-    1 ADC  

-    WI-FI module  

-    PCB antenna 



Basic NodeMCU for Internet of Things (IoT) 

5 
 

ขั้นตอนติดตั้ง NodeMCU ใน Arduino IDE 

ไปที่ Arduino IDE เลือก Preference 

 

ท าการป้อน Additional Boards Manager URL 

http://arduino.esp8266.com/staging/package_esp8266com_index.json 
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หลังจากนั้นไปที่ Menu Tools > Board Manager…  

 

จะข้ึนหน้าจอ Board Manager 

 



Basic NodeMCU for Internet of Things (IoT) 

7 
 

ใส่ ESP8266 เพ่ือค้นหา package จากนั้น install version ล่าสุด 

 

เมื่อ Install เสรจ็สิ้นแล้วจะมี Board NodeMCU ขึ้นมา 
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ลองเสียบสาย USB ที่ NodeMCU หากไม่พบ Port ที่เชื่อมต่อ ให้เช็คในส่วนของ Device Manager ว่า Windows 
ตรวจเจอ Driver ของ Chip CP2102 หรือไม่ ปัญหาส่วนใหญ่คือ Windows ไม่เจอ Driver ของ CP2102 

 

ให้ท าการ Download Driver CP2102 มาติดตั้ง 
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ในกรณีที่ไม่เจอ Com port ต้องท าการ Update USB Driver CP2102   

 

เลือกค้นหาจาก Driver ที่ Copy มาให้ 
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เมื่อติดตั้งเสร็จจะสามารถเลือก Com port ที่เชื่อมต่ออยู่ได้
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ทดสอบ NodeMCU ด้วยการ Scan Wifi 
เลือกบอร์ด NodeMCU โดยเลือก version 1.0 และ   Board late อยู่ที่ 115200 

 

เปิดตัวอย่างในส่วนของ File > Examples > ESP8266WiFi > WiFiScan 
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จะได้ code ของ Wi-Fi scan ให้เราท าการคอมไพล์และอัพโหลดเข้าไปในตัว NodeMCU  

 

เมื่อเราท าการอัพโหลดเสร็จสิ้นแล้วในส่วนของ status box จะแสดงข้อความว่า Done uploading 
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    ให้เราเปิด serial monitor จะแสดงรายการของ wifi ที่เปิดอยู่ท่ีส าคัญคือการเลือกบอร์ดเรทของ serial 
monitor ต้องตรงกับบอร์ดเรทของ NodeMCU ที่เราใช้ คือ 115200 

 

ถ้าข้ึนตามภาพเป็นอันเสร็จสิ้นกระบวนการเราสามารถใช้งาน NodeMCU ได้ 
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ทดลองใช้งาน NodeMCU 

     ในการใช้การเชื่อมต่อขาสัญญาณ Input Output ต่าง ๆ จากตัว NodeMCU ปกติแล้วเราสามารถอ้างอิง
ขาสัญญาณต่าง ๆ ของ NodeMCU ได้โดยใช้ d0 d1 d2 หรืออ้างอิงจาก GPIO ของ ESP8266 โดยตรงเลยก็ได้ 
ซึ่งจะเป็นตัวเลขอย่างเช่น d0 จะเป็นเลข 16, d1 จะเป็นเลข 5, d2 จะเป็นเลข 4 ในการใช้งานจริงนั้นแนะน าให้ใช้
เป็นเลขท่ีออกมาจากขา GPIO ของ ESP8266 โดยตรง เพราะในกรณีที่เราน าไปใช้เป็น production เราไม่จ าเป็น
ที่จะต้องแก้โค้ดจาก d0 เป็นเลข 16 เวลาเราใช้ production ส่วนใหญ่เราจะน า ESP8266 ที่เบิร์น firmware 
และโปรแกรมของเราเอาไว้แล้วไปใช้งาน 

LAB01: Digital Output  
  ท าการต่อวงจรดังภาพ เปิด ArduinoIDE และเลือก Menu File > Example > Basic > Blink แล้วน า 
Code มาแก้ได้ 
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     หลักคือ ใช้ function ที่ใช้ก าหนด pinMode ให้เป็น OUTPUT และใช้ function digitalwrite ส่งค่า
ออกเป็น LOW หรือ HIGH 

pinMode(pout, OUTPUT); 
digitalWrite(pout, HIGH);   // LOW, HIGH หรือ 0,1 ก็ได้ 

 

LAB01: Digital Output 

const int pout = 2;  // เราสามารถใช้ D4 แทนได้ GPIO 2 นี้จะมีแอลอีดีเชื่อมต่ออยู่บนตัว ESP8266 ด้วย 

 

void setup() { 
 pinMode(pOUT, OUTPUT); 
} 
 

void loop() { 
 digitalWrite(pOUT, HIGH);    
 delay(1000);              
 digitalWrite(pOUT, LOW);    
 delay(1000);              
} 
 

ผลทดสอบ run ไฟที่ตัวของ ESP8266 จะกระพริบติดดับ 1 วินาที และ LED ที่ต้อไว้จะติดดับสลับกัน 
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LAB02: Digital Input  
  ท าการต่อวงจรดังภาพ เปิด ArduinoIDE และเลือก Menu File > Example > Digital > button แล้ว
น า Code มาแก้ได้ 

 
      ในส่วนของ digital in นี้เราจะทดสอบด้วยการต่อ Switch และ LED เมื่อกด Switch แล้ว LED จะติด
และเม่ือปล่อย Switch แล้ว LED จะดับ  

      ข้อควรจ าและต้องระวังให้มากที่สุดคือการดีไซน์วงจรใช้งานแล้วท าให้ Short Circuit หรือแหล่งจ่ายไฟไป
เชื่อมต่อกับกราวด์ Ground โดยตรงต้องระวังไว้ให้มากถ้าไม่มั่นใจไม่ควรเสียบโดยตรงกับ NodeMCU  ให้ท าการ
ต่อวงจรทดสอบข้างนอกก่อน 

      หลักคือ ใช้ function ก าหนด pinMode ให้เป็น INPUT และใช้ function digitalread จากพอร์ตที่
ต้องการอ่านค่า ซึ่งจะได้คา่ออกมาเป็น logic LOW หรือ HIGH 

pinMode(ledPin, INPUT); 
digitalWrite(buttonPin);   //ค่าท่ีได้จะออกมาเป็น logic LOW, HIGH 
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LAB02: Digital Input 

const int buttonPin = 0;     // the number of the pushbutton pin 

const int ledPin =  2;      // the number of the LED pin 

int buttonState = 0;         // variable for reading the pushbutton status 

 

void setup() { 
 pinMode(ledPin, OUTPUT);     // initialize the LED pin as an output: 
 pinMode(buttonPin, INPUT);   // initialize the pushbutton pin as an input: 
} 
 

void loop() { 
 buttonState = digitalRead(buttonPin);    // read the state of the pushbutton value: 
 if (buttonState == HIGH) {                    // if it is, the buttonState is HIGH: 
   digitalWrite(ledPin, HIGH);                  // turn LED on: 
 } else { 
   digitalWrite(ledPin, LOW);                  // turn LED off: 
 } 
} 
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LAB03: การส่งค่าออก Serial 
     ในการพัฒนาโปรแกรมนั้นหลายครั้งที่เราจะต้องส่งค่าผ่าน serial เพ่ือให้เรารู้การท างานของโปรแกรมที่
เราใส่ไว้ใน NodeMCU เราจึงจ าเป็นต้องรู้ลักษณะการก าหนดค่า serial และการใช้งาน serial เบื้องต้น 

     อย่างแรกที่จ าเป็นต้องก าหนดคือการก าหนด Baud Rate  ของ serial ส่วนใหญ่เรามักจะก าหนดให้
ฟังก์ชัน setup ในที่นี้ Baud Rate ที่จะใช้กับ NodeMCU  คือ 115200 และส่วนที่ 2 คือการน าค่าของ serial มา
แสดงออกทาง serial monitor ด้วยค าสั่ง serial print โดยจะมี 2 ฟังก์ชันหลักคือ   serial.print() คือการ
แสดงผลโดยไม่ขึ้นบรรทัดใหม่ และ serial.println()  คือการแสดงผลโดยขึ้นบรรทัดใหม่ 

LAB03: Send to Serial 

void setup() { 
 Serial.begin(115200);      // initialize serial communication at 115200 bits per second: 
} 
void loop() { 
 Serial.print("My Name: ");  // แสดงผลโดยไม่ขึ้นบรรทัดใหม่ 
 Serial.println("Maximus");  // แสดงผลแล้วขึ้นบรรทัดใหม่ 
 delay(5000);        // delay in between reads for stability 

} 

ผลที่ได้คือเมื่อเปิดโปรแกรม hercules จะข้ึนข้อความ “My Name: Maximus” แล้วขึน้บรรทัดใหม่ไปได้เรื่อยๆ 
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LAB04: การอ่านค่าจาก Serial 
      การอ่านค่าจาก Serial หลังจากที่เราส่งออกไปได้แล้ว มาทดลองรับค่าจากคอมพิวเตอร์บ้าง วิธีการรับ
ข้อมูลเข้าจาก คอมพิวเตอร์ จะใช้ฟังก์ชั่น Serial.Read() ซึ่งในตัวอย่างนี้ช่วยให้เข้าใจมากขึ้น หลังจาก upload 
แล้วเปิด Serial Monitor serial.read() จะเป็นฟังก์ชั่น ที่คืนค่ารับมาจาก serial ซึ่งในท่ีนี้เป็นตัวอักษร จะน ามาใช้
งานเราจึง ต้องประกาศตัวแปร มารับค่า และน าค่าไปประมวลผลต่อไป ส าหรับในโปรแกรมนี้ เราได้รับค่า และ
พิมพ์ค่า ออก Serial Monitor โดยเพิ่ม “>” เข้าไปข้างหน้าด้วย 

LAB04: Read from Serial 

void setup() {  Serial.begin(115200);  
 Serial.println("Hello Please Type"); }  
void loop() {  
 if (Serial.available() > 0)  // Function available มีหน้าที่ตรวจสอบว่ามีการส่งค่าออกมาจาก serial ไหม
ถ้ามีการส่งค่ามาจะ return value ที่มีค่ามากกว่า 0 

 {  char incomingByte = Serial.read();  //  serial.print() ท าหน้าที่อ่านค่าจาก serial  ทีละตัวอักษร 

   Serial.print ("> ");  
   Serial.println (incomingByte);  // แสดงค่าตัวอักษรที่รับมาจาก serial 
} }  

ผลที่ได้เมื่อเราส่งข้อความออกไปตัว NodeMCU จะส่งค่ากลับมาทีละ Byte โดยใช้โปรแกรม Hercules

 



Basic NodeMCU for Internet of Things (IoT) 

21 
 

LAB05: ทดลอง NodeMCU รับค่าจาก serial เพื่อเปิดปิดไฟ 

      การใช้งาน NodeMCU ควบคุม LED ผ่าน Serial ถือเป็นการเรียนรู้การรับส่งข้อมูลระหว่าง คอมพิวเตอร์ 
กับ NodeMCU หากสามารถเข้าใจการรับส่งข้อมูลแบบ Serial แล้ว การน าไปประยุกต์ใช้กับงาน ต่าง ๆ ก็จะสาม
รถท าได้ง่ายมากยิ่งข้ึน 

LAB05: Control LED by Serial 

#define LED1_Pin 2 

String SerialGET = ""; 
void setup() { 
 Serial.begin(115200); 
 pinMode(LED1_Pin, OUTPUT); 
} 
 

void loop(){ 
while (Serial.available()) { 
   char c = Serial.read(); 
   if (c == '.') { 
       Serial.println(SerialGET); 
       if (SerialGET.indexOf("ON") >= 0) 
           digitalWrite(LED1_Pin, HIGH); 
       else if (SerialGET.indexOf("OFF") >= 0) 
           digitalWrite(LED1_Pin, LOW); 
       SerialGET = ""; 
   }else 

   SerialGET += c; 
  } 
} 

     ผลการทดลอง เมื่อเราท าการ Run ให้เปิด Serial Monitor ขึ้นมา แล้วพิมพ์ “ON.” กดปุ่ม Send เพ่ือ
เปิด LED และพิมพ์ “OFF.” เพ่ือปิด LED การรับข้อมูลมาจาก Serial จะรับมาทีละตัวอักษรผ่านค าสั่ง 
Serial.read() หลักการคือการวนลูปเพื่อเก็บทุกตัวอักษรที่ได้จากค าสั่ง Serial.read() โดยน าไปเก็บไว้ในตัวแปร
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ชนิดสตริง เพ่ือง่ายต่อการน าไปใช้ งานหลักการตรวจว่ารับข้อมูลมาครบหรือยัง คือการตรวจหา “.” เพ่ือก าหนด
สิ้นสุดตัวอักษร การส่ง ข้อมูลผ่าน Serial จะต้องมีการส่งตัวอักษร “.” ทุกครั้ง เมื่อตรวจหา “.” เจอ นั่นหมายความ
ว่าข้อมูลได้ รับมาครบเรียบร้อยแล้ว แล้วจึงน าข้อมูลมาประมวลผลต่อได้เลย 
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LAB06: Analog Input 
     เนื่องจาก ESP8266 นั้นใช้ไฟเลี้ยงอยู่ที่ 3.3v และที่ analog pin รับ input ได้เพียง 0-1v เท่านั้น ต่าง
จาก arduino ที่ใช้ไฟเลี้ยงที่ 5v และ analog pin ก็สามารถรับ input ได้ถึง 0-5v ซึ่ง sensor ทั่วไปนั้นส่วนมาก 
Vout ของ sensor จะมีแรงดันอยู่ที่ประมาณ 0-5v ถ้าเป็น Analog Pin ทั่วไปของ arduino สามารถรับ input ได้
สบาย ๆ แต่ในส่วนของ ESP8266 นั้นจ าเป็นต้องต่อวงจรแบ่งแรงดันค านวณหาค่าแรงดันที่ไม่เกิน 1v มาก เพ่ือที่ 
ADC Pin ของ ESP8266 สามารถอ่านค่าได้อย่างปลอดภัย 

     เมื่อ NodeMCU V1 ออกมา ซึ่งทางผู้ผลิตก็ได้ค านึงถึงจุดนี้ ภายในบอร์ดของ NodeMCU นั้นจึงได้ต่อ
วงจรแบ่งแรงดันไว้ภายในบอร์ด ซึ่งผู้ใช้งานไม่ต้องมานั่งต่อวงจรเอง สามารถต่อสายสัญญาณจาก Vout ของ 
sensor เข้าไปที่ Analog Pin ของบอร์ดตรง ๆ ได้เลย 

  ท าการต่อวงจรเพิ่มตามรูป โดยใช้ Potentiometer เพ่ิมเข้ามา 
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      ค่าที่อ่านได้จาก Analog Pin นั้น ถ้าเราจ่ายไฟที่ 0v ค่าที่อ่านได้จาก analogRead() ก็จะได้เท่ากับ 0 ถ้า
หากจ่ายไฟไปที่ analog pin 3.3v ค่าที่อ่านได้จาก analogRead จะได้เท่ากับ 1023 หมายความว่าแรงดันที่อ่าน
จะอยู่ระหว่าง 0-3.3v ที่ขา Analog Pin ของ NodeMCU 

LAB06: Analog Input 

void setup() { 
 Serial.begin(115200); 
} 
 

void loop() { 
 int sensorValue = analogRead(A0);  // read the input on analog pin 0: 
 Serial.println(sensorValue); // print out the value you read: 
 delay(1000);        // delay in between reads for stability 

} 

ผลที่ได้เมื่อเราหมุนปรับค่า Potentiometer ค่าท่ี Serial ก็จะเปลี่ยนตามด้วย ซึ่งค่าที่ได้จะอยู่ในช่วง  0 - 1023 
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LAB07: Pulse Width Modulation (PWD)  
     โดยปกติแล้ว Digital Port จะสามารถมีได้แค่ 2 สถานะ คือ HIGH (5 โวล์ท  )กับ LOW (0 โวล์ท) เท่านั้น 
จึงท าให้สร้างค่าสัญญาณ Logic ได้เพียง เปิดหรือปิด (1 หรือ 0 , มีไฟหรือไม่มีไฟ  )แค่นั้น  ซึ่งการใช้เทคนิค PWM 
นั้น จะเป็นการท าให้ Digital Port สามารถเขียนค่าได้มากกว่า HIGH หรือ LOW โดย ท าให้สามารถเขียนค่าเป็น
แบบ Analog ได้ NodeMCU มีค่าตั้งแต ่0-1023 โดยวิธีการนั้นจะใช้การปรับสถานะของสัญญาณ Logic HIGH / 
LOW สลับกันไปมาด้วยคาบเวลาหนึ่งๆ โดยค่าที่ได้นั้นจะขึ้นอยู่กับ สัดส่วนเวลาของสัญญาณในช่วงเวลาที่มี
สถานะเป็น HIGH กับช่วงเวลาท่ีเป็น LOW โดย ช่วงเวลาทั้งหมดท่ีสัญญาณมีสถานะเป็น HIGH นั้นเราจะเรียกว่า
เป็น  "ความกว้าง Pulse (Pulse Width)" โดยสัญญาณพัลส์ เมื่อเทียบ  %ของช่วงเวลาที่เป็น HIGH (หรือก็คือ 

 %ของ Pulse Width) กับ  %ของคาบเวลา ( Period) ของพัลส์ลูกนั้น ๆ เราจะเรียกว่า Duty Cycle เพ่ือความ
เข้าใจสามารถดูได้จากตัวอย่างด้านล่าง 

 
  ถ้าจะสร้างสัญญาณเอาต์พุตแบบ PWM (Pulse Width Modulation) ที่ปรับค่า Duty Cycle ได้ ก็
สามารถใช้ค าสั่ง analogWrite() ตัวอย่างหนึ่งต่อไปนี้ สาธิตการท าให้ LED เพ่ิมหรือลดความสว่าง โดยใช้หลักการ
ที่เรียกว่า PWM-based LED Dimming โดยการสร้างสัญญาณ PWM ที่สามารถเปลี่ยนค่า Duty Cycle ได้ โดย
สามารถเลือกขา GPIO 0..15 และค่า Duty Cycle ได้ในช่วง 0..1023 (0% ถึง 100%) 
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    เปิด Menu File > Example > Analog > AnalogInOutSerial แล้วน ามาแก้ไขได้ 

LAB07: PWM 

#define analogInPin A0  // Analog input pin that the potentiometer is attached to 

#define analogOutPin  2 // Analog output pin that the LED is attached to 

 

int sensorValue = 0;        // value read from the pot 
int outputValue = 0;        // value output to the PWM (analog out) 
 

void setup() { 
 Serial.begin(115200);     // initialize serial communications at 115200 bps: 
} 
 

void loop() { 
 sensorValue = analogRead(analogInPin);  // read the analog in value: 
 outputValue = map(sensorValue, 0, 1023, 0, 512); // map it to the range of the analog out: 
   analogWrite(analogOutPin, outputValue);   // change the analog out value: 
 

 // print the results to the serial monitor: 
 Serial.print("sensor = "); 
 Serial.print(sensorValue); 
 Serial.print("\t output = "); 
 Serial.println(outputValue); 
 

 delay(2); 
} 
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LAB08: การแสดงข้อความ LCD display I2C 
ก่อนอ่ืนต้องติดตั้ง Library LiquidCrystal I2C ที่ Library Manager… 

 
 

 
 
 
 
 



Basic NodeMCU for Internet of Things (IoT) 

28 
 

LAB08-1: Scan I2C Address 
#include <Wire.h> 
void setup() { 
Serial.begin (115200); 
while (!Serial) { } // Leonardo: wait for serial port to connect 
Serial.println (); 
Serial.println ("I2C scanner. Scanning ..."); 
byte count = 0; 
Wire.begin(); 
for (byte i = 8; i < 120; i++) 
{ 
   Wire.beginTransmission (i); 
   if (Wire.endTransmission () == 0) 
   { 
      Serial.print ("Found address: "); 
      Serial.print (i, DEC); 
      Serial.print (" (0x"); 
      Serial.print (i, HEX); 
      Serial.println (")"); 
      count++; 
      delay (1); // maybe unneeded? 
   } // end of good response 
} // end of for loop 
Serial.println ("Done."); 
Serial.print ("Found "); 
Serial.print (count, DEC); 
Serial.println (" device(s)."); 
} // end of setup 
void loop() {} 
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Address ที่ใช้คือ 3F 
 
เปิด Menu Example > LiquidCrystalI2C > HelloWorld 
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LAB08-2: Show Text on LCD I2C 
#include <Wire.h>  
#include <LiquidCrystal_I2C.h> 
 
LiquidCrystal_I2C lcd(0x3F,16,2);  // set the LCD address to 0x3F for a 16 chars and 2 line 
 
void setup() 
{ 
  lcd.init();                      // initialize the lcd  
  lcd.backlight(); 
  lcd.setCursor(0,0); 
  lcd.print("Hello, world!"); 
  lcd.setCursor(0,1); 
  lcd.print("Max Developer"); 
} 
 
 
void loop() 
{ 
} 
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LAB09: การใช้ Ultrasonic วัดระยะทาง 
Ultrasonic Ranging Module HC-SR04 โมดูลเพื่อใช้ในการวัดระยะทางโดยไม่มีการสัมผัส 

 
  การท างานของ Ultrasonic sensor ก็เหมือนกบัค้างคาวที่บินในเวลากลางคืน  คือใช้การส่งคลื่นเสียงที่หู
มนุษย์ไม่สามารถได้ยินออกไปสะท้อนวัตถุท่ีต้องการวัดระยะ แล้วจับเวลาเสียงสะท้อน เพ่ือค านวณระยะทาง 

 
เพ่ือความเข้าใจกันมากข้ึน  อุปกรณ์ตัวนี้เริ่มต้นท างานโดยการส่งสัญญาณเริ่มต้นยาว 10 ไมโครวินาที ไปสั่งให้
แหล่งก าเนิดเสียงท างาน  จากนั้นจะส่งคลื่นเสียงความถี่ 40 kHz ออกไป 8 พัสส์  แล้วรอฟังเสียงสะท้อน  ตัวซ้าย
จะเป็นตัวส่งคลื่นเสียงออกไป ส่วนตัวขวาในรูปจะเป็นตัวรับความถ่ีที่สะท้อนกลับมา 
    เนื่องจากเสียงที่ส่งออกไปถึงแม้จะไม่ได้ยินเพราะเกิน 20 kHZ ที่หูมนุษย์จะรับฟังได้  แต่เนื่องจากยังคง
เป็นคลื่นเสียง ดังนั้นความเร็วของเสียงจึงแปรผันตามอุณหภูมิด้วยตามสูตรนี้ 
 

C ≈ 331.5 + 0.61 θ (m/s) 
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  ดังนั้นแน่นอนเวลาผู้ผลิตเขียนโปรแกรมออกแบบไว้ก็อยู่ที่อุณภูมิท างานที่อาจจะแตกต่างจากบ้านเรา ก็
ท าให้ค่าที่วัดได้มีความผิดพลาดไปบ้าง 
  อีกส่วนที่จะต้องรู้ก็คือช่วงวัด และมุมที่สามารถวัดได้ครับ  และเนื่องจากคุณสมบัติของอุปกรณ์ท่ีใช้ในการ
ก าเนิดเสียง และรูปร่างของตัวล าโพง (Horn) ก็ท าให้อุปกรณ์ตัวนี้มีมุมวัด 15 องศา (Measuring Angle) โดย
สามารถวัดระยะห่างได้ตั้งแต่ 2 ซม  .จนถึง 4 เมตร   
 
ระยะทางก็ค านวณได้จากสูตรนี้ 
 
ระยะทาง  =ความยาวของสัญญาณสะท้อน x 340 (m/s)  / 2 
 
และแน่นอนครับคุณภาพของสัญญาณ ความแม่นย าก็ขึ้นกับวัสดุ  +ลักษณะของพ้ืนผิวที่ใช้วัดด้วย  
 

 
 
ระดับแรงดันที่ใช้คือ 5 v  
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LAB09-1: Basic Ultrasonic 
#define TRIGGER_PIN  9 // SD2 - GPIO9 
#define ECHO_PIN     10  // SD3 - GPI109 
 
void setup() { 
  Serial.begin (9600); 
  pinMode(TRIGGER_PIN, OUTPUT); 
  pinMode(ECHO_PIN, INPUT); 
  pinMode(BUILTIN_LED, OUTPUT); 
} 
 
void loop() { 
  long duration, distance; 
  digitalWrite(TRIGGER_PIN, LOW);  // Added this line 
  delayMicroseconds(2); // Added this line 
  digitalWrite(TRIGGER_PIN, HIGH); 
  delayMicroseconds(10); // Added this line 
  digitalWrite(TRIGGER_PIN, LOW); 
  duration = pulseIn(ECHO_PIN, HIGH); 
  distance = (duration/2) / 29.1; 
  Serial.print(distance); 
  Serial.println(" cm"); 
  delay(1000); 
} 
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ใช้ Library 
LAB09-2: Ultrasonic Library 
#include <Ultrasonic.h> 
Ultrasonic ultrasonic(9,10); // (Trig PIN,Echo PIN) 
void setup() { 
  Serial.begin(9600);  
} 
void loop() { 
  Serial.print(ultrasonic.Ranging(CM)); // CM or INC 
  Serial.println(" cm" ); 
  delay(100); 
} 

 
Code ที่ปรับใหม่ 
LAB09-3: Ultrasonic LCD I2C 
#include <Wire.h>  
#include <LiquidCrystal_I2C.h> 
#include <Ultrasonic.h> 
 
LiquidCrystal_I2C lcd(0x3F,16,2);  // set the LCD address to 0x3F for a 16 chars and 2 line 
Ultrasonic ultrasonic(9,10); 
 
void setup() 
{ 
  lcd.init();                      // initialize the lcd  
  lcd.backlight(); 
  lcd.setCursor(0,0); 
  lcd.print("Ulteasonic"); 
  lcd.setCursor(0,1); 
  lcd.print("Sensor >"); 
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  delay(1000); 
  lcd.print(">"); 
  delay(1000); 
  lcd.print(">");   
  delay(1000); 
  lcd.print(">"); 
  delay(1000); 
  lcd.print(">"); 
  delay(1000); 
  lcd.print(">"); 
  delay(1000); 
  lcd.print(">");   
} 
 
 
void loop() 
{ 
  lcd.clear(); 
  lcd.setCursor(0, 0); 
  lcd.print(ultrasonic.Ranging(CM)); // CM or INC 
  lcd.print(" cm"); 
  lcd.setCursor(0, 1); 
  lcd.print(ultrasonic.Ranging(INC)); // CM or INC 
  lcd.print(" inc"); 
  delay(100); 
} 
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LAB10: การใช้ Motion Sensor 
PIR Motion Sensor Getting Started 
 
PIR  (Passive infrared ) 
คือ อุปกรณ์ตรวจจับคลื่นรังสี Infrared จากวัตถุ ผ่านอุปกรณ์รวมแสง มายังตัว Pyro Electric ซึ่งจะเปลี่ยน
พลังงานความร้อน จากรังสี Infrared เป็นพลังงานไฟฟ้า แม้จะมีประมาณ Infrared แค่เพียงเล็กน้อย จึงท าให้ 
PIR สามารถตรวจจับ คลื่นรังสี Infrared และ อุณหภูมิได้ 
 
PIR Motion Sensor 
คือ อุปกรณ์ Sensor ชนิดหนึ่งที่ใช้ตรวจจับคลื่นรังสี Infrared ที่แพร่จาก มนุษย์ หรือ สัตว์ ที่มีการเคลื่อนไหว ท า
ให้มีการน าเอา PIR มาประยุคใช้งานกันเป็นอย่างมากใช้เพ่ือตรวจจับการเคลื่อนไหวของสิ่งมีชีวิต หรือ ตรวจจับ
การบุกรุกในงานรักษาความปลอดภัย    
 
การท างานของ PIR Sensor 

 
ภายใน PIR จะมีอุปกรณ์ตรวจจับรังสี Infrared อยู่ 2 ชุดด้วยกันดังรูป เมื่อมี คน หรือ สัตว์ ที่มีความอบอุ่นใน
ร่างกายเคลื่อนที่ผ่านเข้ามาใน พื้นที่โซนที่ PIR สามารถตรวจจับคลื่นรังสี Infrared ที่แพร่ออกมาจากสิ่งมีชีวิตได้ 
PIR จะเปลี่ยนคลื่นรังสี Infrared ให้กลายเป็น กระแสไฟฟ้าดังรูป จะเห็นว่าเมื่อมีสิ่งมีชีวิต เคลื่อนที่ผ่าน อุปกรณ์
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ตรวจจับรังสี Infrared ตัวที ่1 จะได้สัญญาณ Output ออกมาสูงกว่าแรงดันปรกติ และ เมื่อสิ่งมีชีวิตเคลื่อนที่ผ่าน 
อุปกรณ์ตรวจจับรังสี Infrared ตัวที่ 2 จะได้แรงดัน Output  ต่ ากว่าค่าแรงดันปรกติ 

 
วงจรที่ใช้ 
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LAB10-1: Basic Motion Sensor 
const int PIRPin = 12;     
const int ledPin =  2;       
int PIRState = 0;          
void setup()  
{  
pinMode(ledPin, OUTPUT);       
  pinMode(PIRPin, INPUT);     
  Serial.begin(9600);  
} 
 
void loop() 
{  
  PIRState = digitalRead(PIRPin); 
if(PIRState == HIGH) 
      { 
             Serial.print("\r\nALARM"); 
      }else{ 
            Serial.print("\r\nNORMAL"); 
      } 
  digitalWrite(ledPin,PIRState);  
  delay (500); 
} 
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Code ทีป่รับแล้ว 
LAB10-2: Advance Motion Sensor 
//the time we give the sensor to calibrate (10-60 secs according to the datasheet) 
int calibrationTime = 30;         
 
//the time when the sensor outputs a low impulse 
long unsigned int lowIn;          
 
//the amount of milliseconds the sensor has to be low  
//before we assume all motion has stopped 
long unsigned int pause = 5000;   
 
boolean lockLow = true; 
boolean takeLowTime;   
 
int pirPin = 12;    // D6 the digital pin connected to the PIR sensor's output 
int ledPin = 2;     // D4 
 
 
///////////////////////////// 
//SETUP 
void setup(){ 
  Serial.begin(9600); 
  pinMode(pirPin, INPUT); 
  pinMode(ledPin, OUTPUT); 
  digitalWrite(pirPin, LOW); 
 
  //give the sensor some time to calibrate 
  Serial.print("calibrating sensor "); 
    for(int i = 0; i < calibrationTime; i++){ 
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      Serial.print("."); 
      delay(1000); 
      } 
    Serial.println(" done"); 
    Serial.println("SENSOR ACTIVE"); 
    delay(50); 
  } 
 
//////////////////////////// 
//LOOP 
void loop(){ 
 
     if(digitalRead(pirPin) == HIGH){ 
       digitalWrite(ledPin, HIGH);   //the led visualizes the sensors output pin state 
       if(lockLow){   
         //makes sure we wait for a transition to LOW before any further output is made: 
         lockLow = false;             
         Serial.println("---"); 
         Serial.print("motion detected at "); 
         Serial.print(millis()/1000); 
         Serial.println(" sec");  
         delay(50); 
         }          
         takeLowTime = true; 
       } 
 
     if(digitalRead(pirPin) == LOW){        
       digitalWrite(ledPin, LOW);  //the led visualizes the sensors output pin state 
 
       if(takeLowTime){ 
        lowIn = millis();          //save the time of the transition from high to LOW 
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        takeLowTime = false;       //make sure this is only done at the start of a LOW phase 
        } 
       //if the sensor is low for more than the given pause,  
       //we assume that no more motion is going to happen 
       if(!lockLow && millis() - lowIn > pause){   
           //makes sure this block of code is only executed again after  
           //a new motion sequence has been detected 
           lockLow = true;                         
           Serial.print("motion ended at ");      //output 
           Serial.print((millis() - pause)/1000); 
           Serial.println(" sec"); 
           delay(50); 
           } 
       } 
  } 

 

LAB11: การวัดอุณหภูม ิและ ความชื้นด้วย DHT11 

  DHT11 Humidity and Temperature Sensor กับบอร์ด NodeMCU ใช้ในการวัดอุณหภูมิกับความชื่น
ในอากาศที่มี Specification ตามนี้ 

 
- ย่านวัดความชื่น 20-90% RH   โดยมีค่าความแม่นย า +- 5% RH  ความละเอียดในการวัด 1 % 
แสดงผลแบบ 8 บิต 
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- ย่านวัดอุณหภูมิ 0 -50 องศาเซลเซียส โดยมีค่าความแม่นย า +- 2 องศาเซลเซียส  ความละเอียดใน
การวัด 1 องศาเซลเซียส แสดงผลแบบ 8 บิต 

- กินกระแส 0.5 - 2.5 mA (ขณะท าการวัดค่า( ที่ระดับแรงดัน 3 - 5.5 VDC 

- อ่านค่าสัญญาณ )Sample Rate) ทุก 1 วินาที 

- การสื่อสารกับ MCU ของเราด้วยวิธี Single-wire Two-way Serial interface คือการสื่อสารแบบ
อนุกรมด้วยสายสัญญาณเส้นเดียว 

    ในการ install library ของ Arduino IDE เราสามารถไปที่ Menu Sketch > Include Library > Manage 
Library และพิมพ์ DHT11 หลังจากนั้นกดปุ่ม install เรากจ็ะได้ library มาใช้ได้อย่างง่ายดายหรืออีกวิธีนึงเรา
สามารถ install ในลักษณะที่เป็น zip file ได้อีกด้วย 
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  ท ำกำรตอ่วงจรดงัภำพ เปิด ArduinoIDE และเลือก Menu File > Example > DHT sensor library > 

DHTTester แล้วน ำ Code มำแก้ได้ 
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LAB11: DHT11 Temperature and Humidity Sensor 

#include "DHT.h" 
 

#define DHTPIN 14    // what digital pin we're connected to D5 

 

// Uncomment whatever type you're using! 
#define DHTTYPE DHT11   // DHT 11 

//#define DHTTYPE DHT22   // DHT 22  (AM2302), AM2321 

//#define DHTTYPE DHT21   // DHT 21 (AM2301) 
// Connect pin 1 (on the left) of the sensor to +5V 

// NOTE: If using a board with 3.3V logic like an Arduino Due connect pin 1 

// to 3.3V instead of 5V! 
// Connect pin 2 of the sensor to whatever your DHTPIN is 

// Connect pin 4 (on the right) of the sensor to GROUND 

// Connect a 10K resistor from pin 2 (data) to pin 1 (power) of the sensor 
// Initialize DHT sensor. 
// Note that older versions of this library took an optional third parameter to 

// tweak the timings for faster processors.  This parameter is no longer needed 

// as the current DHT reading algorithm adjusts itself to work on faster procs. 
DHT dht(DHTPIN, DHTTYPE); 
 

void setup() { 
 Serial.begin(115200); 
 Serial.println("DHT11 test!"); 
 dht.begin(); 
} 
 

void loop() { 
 delay(2000); 
 

 // Reading temperature or humidity takes about 250 milliseconds! 
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 // Sensor readings may also be up to 2 seconds 'old' (its a very slow sensor) 
 float h = dht.readHumidity(); 
 // Read temperature as Celsius (the default) 
 float t = dht.readTemperature(); 
 // Read temperature as Fahrenheit (isFahrenheit = true) 
 float f = dht.readTemperature(true); 
 

 // Check if any reads failed and exit early (to try again). 
 if (isnan(h) || isnan(t) || isnan(f)) { 
   Serial.println("Failed to read from DHT sensor!"); 
   return; 
 } 
 // Compute heat index in Fahrenheit (the default) 
 float hif = dht.computeHeatIndex(f, h); 
 // Compute heat index in Celsius (isFahreheit = false) 
 float hic = dht.computeHeatIndex(t, h, false); 
 

 Serial.print("Humidity: "); 
 Serial.print(h); 
 Serial.print(" %\t"); 
 Serial.print("Temperature: "); 
 Serial.print(t); 
 Serial.print(" *C "); 
 Serial.print(f); 
 Serial.print(" *F\t"); 
 Serial.print("Heat index: "); 
 Serial.print(hic); 
 Serial.print(" *C "); 
 Serial.print(hif); 
 Serial.println(" *F"); 
} 
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LAB12: ท่า NodeMCU เป็น Web Server 
สั่งเปิดปิดอุปกรณ์ผ่าน URL  

ไปที่ Menu File > Example > ESP8266 Wifi > WifiWebServer แล้วแก้ไข SSID และ Password ให้ตรง 
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LAB13: ท่า NodeMCU เป็น Web Client 
ทดสอบโดยใช้ Hercules เปน้ Server 
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Arduino IDE ไปที่ Menu File > Example > ESP8266 Wifi > WifiClientBasic แล้วแก้ไข SSID และ 
Password ให้ตรง 
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การใช้งาน Cloud Broker ส่าหรับงาน IoT 

      ในการท า IoT นั้นเราจะใช้ Cloud เป็นตัวกลางในการสื่อสารข้อมูลระหว่าง Node กับ server ซ่ึง Cloud 
ที่เปิดให้บริการ IoT อยู่นั้นส่วนใหญ่จะเป็นแค่ตัวกลางในการสื่อสารหรือบางตัวสามารถช่วยในการเก็บข้อมูลและ
แสดงผล โดยที่ตัวมันเองนั้นจะท าเสมือนเป็น broker ซึ่งจะไม่มีการตัดสินใจหรือว่าเงื่อนไขในการท างานใดๆอยู่ที่
ตัว broker  

     นั่นหมายความว่าหากเราต้องการให้ระบบ IoT ของเรานั้นมีเงื่อนไขในการท างานอย่างเช่นอุณหภูมิที่
ตรวจจับจากเซนเซอร์วัดอุณหภูมิมีค่ามากกว่า 30 องศาให้เปิดพัดลม แต่หากน้อยกว่า 25 องศาให้พัดลมหยุด
ท างานการท างานในลักษณะนี้ตัว broker ไม่สามารถท าได้ดังนั้นเราจึงจ าเป็นต้องมี server ส าหรับช่วยในการท า
เงื่อนไขต่าง ๆ broker   เป็นเพียงสื่อกลางในการรับส่งข้อมูลหรืออย่างดีที่สุดก็ช่วยในการเก็บข้อมูลเพ่ือส่งต่อและ
แสดงผลออกมาบน Cloud  ได้เลย 

LAB14: ท่า Data Logger โดยสง่ Data ไปที่ SparkFun 

SparkFun เป็น Broker ที่ท าหน้าที่เก็บข้อมูลของตัวอุปกรณ์ IoT ต่าง ๆ ที่ส่ง Data มาเก็บไว้บน cloud เรา
สามารถใช้งานโดยไม่ต้อง register โดยเข้าไปที่ sparkfun.com และเลือก create  

https://data.sparkfun.com/ 

 

ใส่รายละเอียดในการสร้าง deta stream  ที่ส าคัญคือ Title และ Fields  

https://data.sparkfun.com/
https://data.sparkfun.com/
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เมื่อบันทึกเรียบร้อยแล้วจะเข้ามาหน้าที่แสดงคีย์ต่างๆที่ส าคัญก็คือ public url,  public key  และ private key 
รวมถึง  Field Parameter ที่เราสร้างเอาไว้เพ่ือให้ node mcu ส่งมาด้วยชื่อที่ตรงกัน  โดยลักษณะการส่งนั้นจะ
เป็นการส่งแบบ url Parameter ตามตัวอย่างท่ีให้มาด้านล่าง 
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    ในส่วนของ Arduino IDE  ไปที่ Menu File > Example > ESP8266WIFI > WIFI Client  ให้เราท าการใส่ 
ssid และ password  ในส่วนของ Stream ID ให้ใส่ public key  ในส่วนของ private key ก็ใส่ข้อมูลของ 
private key และในส่วนของ Value ใส่ให้ตรงกับ Parameter ที่เราได้สร้างเอาไว้ 
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หากมีการแจ้งว่า success แสดงว่าข้อมูลที่ node mcu ส่งไปนั้นได้อัพเดทเข้าไปยัง spark fun เรียบร้อยแล้ว 
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เราสามารถเข้าไปดูข้อมูลได้จาก public url  และข้อมูลเหล่านี้สามารถ export ออกมาในรูปแบบต่างๆได้ไม่ว่าจะ
เป็น JSON, csv, mysql, ProtgreSQL, atom ซึ่งจะมีค่าข้อมูลต่างๆพร้อมทั้ง TimeStamp  
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LAB15: วิธีเอา Data จาก SparkFun ไปแสดงผลที่ AnalogIO 

    จากการที่ SparkFun ได้ท าการเก็บ data เป็นลักษณะ table มันเป็นการไม่ง่ายเลยที่จะน าข้อมูลเหล่านี้ไปใช้ 
ดังนั้นเราจึงน า data นี้ไปแสดงผลในรูปแบบกราฟโดย SparkFun  ได้มีอินเตอร์เฟสกับทาง AnalogIO ในการน า
ข้อมูลเชื่อมต่อและแสดงผลออกมาเป็นรูปแบบของกราฟที่เข้าใจได้ง่าย ในส่วนของหน้า data stream จะมีปุ่ม
ฟังก์ชั่น export to analog io 

 

    ในส่วนของ analog i o จ าเป็นที่จะต้องท าการ register user เพ่ือใช้งานในการ manage แต่หากเราไม่ได้ 
register เราก็สามารถท่ีจะดูข้อมูลที่สปาร์คฟันส่งมาให้เป็นกราฟได้อย่างง่าย  
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เมื่อท าการ login เข้ามาแล้วเราจะเข้ามายังหน้า manage ของ analog io เราสามารถสร้าง create streamใหม ่
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และเม่ือเรา Export มาจาก SparkFun มาท่ี analog IO แล้วให้เราเลือก Claim จะข้ึน Dialog มาถามให้ใส่ 
Private Key เพ่ือยืนยัน 
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LAB16: ใช้ ThingSpeak เป็น Data Logger พร้อม Plot Graph 

    Thingspeak เป็นเว็ปที่ให้การบริการในการเก็บข้อมูล และสามารถแสดงข้อมูลแบบ real-time ได้ ซึ้งเรา
สามารถ update ข้อมูล หรือจะเรียกดูข้อมูลได้ตลอดเวลา ที่ไหนก็ได้ เพราะท างานบน cloud ซ่ึง thingspeak 
สร้างมาเพ่ือต้องการให้ตอบโจทย์ของ IoT อยู่แล้ว ส่วนข้อมูลที่เก็บอยู่บน cloud นั้นก็ขึ้นอยู่กับเราว่าจะใช้ยังไง 
รูปแบบไหน ในการที่จะส่งข้อมูล data ไปไว้บน cloud นั้น ทาง thingspeak ได้มี api ในการติดต่อไว้เรียบร้อย
แล้ว 

    อันดับแรกเลย ให้ท าการสมัครสมาชิกให้เรียบร้อย จากนั้นก็สร้าง channel ขึ้นมา โดยให้เรากดไปที่ My 
channel แล้วก็ new channel ขึ้นมา 
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    หลังจากท่ี new channel ขึ้นมาแล้ว ไปที่ channel setting ก็ป้อนข้อมูลเข้าไป เสร็จแล้วก็กด save 
channel 

 
    เมื่อสร้างเสร็จแล้ว ก็จะแสดงหน้าต่าง ในหน้าต่างนี้จะแสดงข้อมูลเป็นแบบเส้นกราฟ ซึ่งตอนนี้ยังไม่มีข้อมูลใด 
ๆ ส่งมาจึงไม่เกิดอะไรขึ้น 
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    ต่อไปจะท าการ update ข้อมูลไปยัง cloud ผ่าน api ที่ thingspeak มีไว้ให้ อันดับแรกให้ดูที่ API KEY ของ
เราว่ามันคืออะไร API KEY คือ UAV0TAOTBCTLA6V1 ตามรูป 

 

    ในการ update ข้อมูลจะเป็นการส่ง HTTP Request ไปยัง server เพ่ือ update ข้อมูลที่ต้องการตาม field 
ต่าง ๆ ที่เราก าหนด วิธีการ update โดยเราจะส่งข้อมูลแบบนี้ 

https://api.thingspeak.com/update?key=UAV0TAOTBCTLA6V1&field1=0&field2=0&field3=0 

ที่ขีดเส้นไว้คือ 

               UAV0TAOTBCTLA6V1 คือ API KEY 

   bkvalue=0 คือ field ที่เราต้องการ update ในตัวอย่างคือ field ที่ 1 และก าหนดให้มีค่าเท่ากับ 0 

    จากรูปตัวอย่างฝั่งขวาคือได้ท าการ update ข้อมูล โดยก าหนดให้ field ที่ 1 มีค่าเท่ากับ 0 และฝั่งซ้ายนั้นได้มี
จุดเพิ่มมา 1 จุดก็คือค่าที่เราเพ่ิมไปเมื่อซักครู่นั่นเอง 
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    ต่อมาเรามาเขียนโปรแกรมให้กับ NodeMcu ให้ส่งข้อมูล update   

LAB16: ThingSpeak Data Logger 
#include <ESP8266WiFi.h> 
#include "DHT.h" 
#define DHTPIN 14 
#define DHTTYPE DHT11 
int sensorPin = A0; 
int sensorValue = 0; 
 
const char* ssid     = "BUAKAEW_AP01"; 
const char* password = "BuaKaew159357"; 
const char* host = "api.thingspeak.com"; 
const char* APIKey = "UAV0TAOTBCTLA6V1"; 
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DHT dht(DHTPIN, DHTTYPE); 
 
void setup() { 
  Serial.begin(115200); 
  dht.begin(); 
  delay(10); 
  // We start by connecting to a WiFi network 
  Serial.println(); 
  Serial.println(); 
  Serial.print("Connecting to "); 
  Serial.println(ssid); 
  WiFi.begin(ssid, password); 
  while (WiFi.status() != WL_CONNECTED) { 
    delay(500); 
    Serial.print("."); 
  } 
  Serial.println(""); 
  Serial.println("WiFi connected");   
  Serial.println("IP address: "); 
  Serial.println(WiFi.localIP()); 
} 
 
void loop() { 
  delay(10000); 
  // Sensor readings may also be up to 2 seconds 'old' (its a very slow sensor) 
  float h = dht.readHumidity(); 
  // Read temperature as Celsius (the default) 
  float t = dht.readTemperature(); 
  // Check if any reads failed and exit early (to try again). 
  if (isnan(h) || isnan(t) ) { 
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    Serial.println("Failed to read from DHT sensor!"); 
    return; 
  } 
  Serial.print("connecting to "); 
  Serial.println(host); 
   
  // Use WiFiClient class to create TCP connections 
  WiFiClient client; 
  const int httpPort = 80; 
  if (!client.connect(host, httpPort)) { 
    Serial.println("connection failed"); 
    return; 
  } 
  sensorValue = analogRead(sensorPin); 
  // We now create a URI for the request 
  String url = "/update"; 
  url += "?key="; 
  url += APIKey; 
  url += "&field1="; 
  url += h; 
  url += "&field2="; 
  url += t;   
  url += "&field3="; 
  url += sensorValue; 
     
  Serial.print("Requesting URL: "); 
  Serial.println(url); 
   
  // This will send the request to the server 
  client.print(String("GET ") + url + " HTTP/1.1\r\n" + 
               "Host: " + host + "\r\n" +  
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               "Connection: close\r\n\r\n"); 
  unsigned long timeout = millis(); 
  while (client.available() == 0) { 
    if (millis() - timeout > 5000) { 
      Serial.println(">>> Client Timeout !"); 
      client.stop(); 
      return; 
    } 
  } 
   
  // Read all the lines of the reply from server and print them to Serial 
  while(client.available()){ 
    String line = client.readStringUntil('\r'); 
    Serial.print(line); 
  } 
   
  Serial.println(); 
  Serial.println("closing connection"); 
} 
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LAB17: ใช้ ThingSpeak เป็น ควบคุมตัว NodeMCU 

    วิธีที่เราจะควบคุม LED นั้นเราจ าเป็นต้องมีข้อมูลเพื่อน าไปเช็คเป็นเงื่อนไขว่า ถ้าเกิดเป็นค่านี้ให้ LED เปิด ถ้า
เป็นอีกค่านึงให้ LED ปิด ดังนั้นหากเราต้องการสั่งให้ LED เปิดหรือปิดผ่าน Internet นั้น เราจึงจ าเป็นต้องมีข้อมูล
บน cloud โดยเราจะท าการส่ง Http request ไปยัง server เพ่ือร้องขอข้อมูลที่เราต้องการ ถ้าเราส่ง  http 
request ได้อย่างถูกต้องก็จะมี http response ตอบกลับจาก server โดยส่งมาพร้อมกับข้อมูลที่เราต้องการ และ
เราก็ท าการเขียนโปรแกรมเพ่ือใช้ค่าที่ server ตอบกลับมานั้น มาเป็นค่าในการควบคุม LED เพ่ือเปิดหรือปิด
นั่นเอง 

 

    การ get data หรือจะเป็นการ update data เราสามารถศึกษา หรือดู Example ได้จาก Documentation 
จาก Support ของ ThingSpeak ได้เลย ในส่วนของการ get data นั้นจะใช้วิธีการ get ตามแบบ Example ตัว
นี้  ซึ่งเป็นการดึงค่าล่าสุดที่เราบันทึกข้อมูลลง database 

    จะลอง get data มาดู ซึ่งจะพิมพ์ url นี้ ลงในช่อง search ของ browser 

https://api.thingspeak.com/channels/129121/fields/1/last 

 

          ที่ขีดเส้นใต้ไว้นั้น 129121 คือช่อง channels ของเรานะครับ ส่วน 1 คือ ต้องการดูที่ field ไหน ส่วน
เลือกดูที่ field 1  

 

https://thingspeak.com/docs/channels#get_feed
https://thingspeak.com/docs/channels#get_feed
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    จากรูปข้างบนก็คือลองเข้าไปยัง url ดังกล่าวผ่าน web browser และเชื่อมต่อไปยัง link นั้น แล้วจะมี 
response ตอบกลับมาเป็นเลข 2 นั่นก็คือค่าท่ีเราต้องการที่จะทราบว่า ค่าที่บันทึกล่าสุดของ field ที่ 1 คือค่า
อะไร ก็มีการ response กลับมาเป็นค่าดังกล่าว 

    ตัวอย่างนี้เป็นเพียงการทดสอบดูว่าสามารถ get ค่าจาก server ได้หรือไม่ ต่อมาเราก็มาดูกันว่า เราจะเขียนให้ 
NodeMcu ของเรานั้นไป get ค่ามาแล้วมาควบคุม LED ได้อย่างไร 

LAB17: ThinkSpeak Control  
#include <ESP8266WiFi.h> 

 

const char* ssid = "BUAKAEW_AP01"; //ใส่ SSID WiFi ที่ต้องการเชื่อมต่อ 

const char* password = "BuaKaew159357"; //ใส่ password ของ WiFi ที่ต้องการเชื่อมต่อ 

const char* host = "api.thingspeak.com"; // ชื่อ host ที่ต้องการติดต่อ 

const char* url = "/channels/129121/fields/1/last"; // path ที่ต้องการเรียก 

 

int lengthData = 0; //ตัวแปรนี้จะเก็บขนาดของข้อมูลที่ทาง Server มีการ response กลับมา 

int data = 0; // ตัวแปรนี้จะเก็บค่าข้อมูลที่เราต้องการใช้งาน 

 

String line = ""; // ตวัแปรนี้จะเก็บค่าท้ังหมดที่อ่านได้จาก Server 
 

int led1 = 14; //ก าหนดขา GPIO OUTPUT ซ่ึง pin นี้จะตรงกับ D1 

 

const int PORT = 80; // ใช้ port 80  
 

WiFiServer server(80); // สร้าง object จาก คลาส WiFiServer ก าหนด port 80 

 

void setup() { 
 Serial.begin(115200); //ใช้ buadrate 115200 

 delay(10); 
  
 pinMode(led1,OUTPUT); // ก าหนด ขา ให้เป็น ขา OUTPUT 

  
 Serial.println("\n\n"); 
 Serial.print("Connecting to ");  
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 Serial.println(ssid);  // แสดงข้อความออกทาง Serial ว่า Connecting to (SSID ที่เชื่อมต่อ( 
 WiFi.begin(ssid, password);  // เชื่อมต่อ wifi จาก SSID และ password ที่เราก าหนด 

  
 while (WiFi.status() != WL_CONNECTED){ // ถ้าหากยังเชื่อมต่อกับ wifi ยังไม่ได้ก็จะแสดงข้อความ ... ไป
เรื่อย ๆ 

   delay(500); 
   Serial.print("."); 
 } 
  
 Serial.println(); 
 Serial.println("WiFi Connected!!"); 
 Serial.print("IP address : "); 
 Serial.println(WiFi.localIP());  // แสดง IP address ที่ได้รับจาก wifi ที่เราเชื่อมต่อ 

} 
 

void loop() { 
 delay(5000); //delay ไว้ 5 วิ  
 Serial.print("Connecting to "); 
 Serial.println(host); //แสดงข้อความทาง Serial ว่า Connecting to (host ที่ต้องการเชื่อมต่อ( 
  
 WiFiClient client = server.available(); // สร้าง client ขึ้นมาจาก WiFiClient และก าหนดให้เท่ากับ 
Server.available() เพ่ือไว้เช็คเวลามีข้อมูลส่งกลับมา 

  
 Serial.print("Requesting URL : "); 
 Serial.println(url); // แสดง url ที่เรา request ไป 

  
 if(!client.connect(host,PORT)){ 
   Serial.print("."); //ในเงื่อนไขนี้เช็คว่าถ้าไม่ได้เชื่อมต่อกับ host อยู่ให้แสดง . ออกมา 

   return; 
 }else{ 
       // และถ้าหากเชื่อมต่ออยู่ให้ส่ง http request ไปที่ server  
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   client.print(String("GET ")+url+" HTTP/1.1\r\n" + 

                       "Host: " + host +"\r\n" + 

                       "Connection: close\r\n\r\n"); 
                     delay(50); 
   Serial.println("SEND !!");  // เมื่อส่งไปแล้วให้แสดงข้อความ SEND !! ออกมา 

 } 
  
 while(!client.available()){ //ถ้าหากไม่มี response ตอบกลับมา ก็จะให้วนลูป จนกว่าจะมี responce 
ตอบกลับมา 

 } 
  
 while(client.available()){ // และเม่ือมี response ตอบกลับมาก็จะให้เข้า loop while แล้วท าการเก็บค่า
ทั้งหมดไว้ที่ line 

   line += (char)client.read(); 
 } 
  
 Serial.println(); 
 Serial.println("GET SUCCESSFULLY !!"); // เมื่อท าการเก็บค่าไว้หมดแล้วก็จะแสดง GET 
SUCCESSFULLY ออกมา 

  
 convertDataToInt(&lengthData , &data ,line); // ใน function นี้เขียนขึ้นมาเพ่ือตัดข้อความบางส่วน
ออก เอาเฉพาะที่เราจ าเป็นต้องใช้งานจริง ๆ ก็จะมี lengthData และ data 

  
 String s =(String)"ID "+lengthData+" data "+data; // สร้างตัวแปร String มาดูผลลัพธ์ว่าข้อมูลที่ได้จาก 
Server  
 Serial.println(s); // แสดงข้อมูลที่ผ่านการ filter เรียบร้อยแล้ว 

   switch(data){ // แล้วก็ต่อมาจะเป็นเงื่อนไขกันเราก็เช็คกับตัวแปร data ว่าเป็นค่าอะไรบ้าง เพ่ือที่เราจะเอา
มาท าเป็นเงื่อนไขในการเปิดปิด LED 

   case 1: 
       digitalWrite(led1,HIGH); // ถ้าเป็น 1 led1 ติด 
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     break; 
   case 0: 
       digitalWrite(led1,LOW);// ถ้าเป็น 2 led1 ดับ 

     break; 
 } 
  
 line = ""; // เมื่อจบ process ทุกอย่างแล้ว ก็เคลียข้อมูลในตัวแปร line ให้เท่ากับ "" เพ่ือรอรับค่าใหม่ใน 
loop หน้า 

 Serial.println(); 
 Serial.println("Closing Connection"); //แสดงข้อความ Closing Connection 

} 
 

void convertDataToInt(int* id_ ,int* data_ ,String rawData){ // พารามิเตอร์ ก็จะมี pointer id_ , 
pointer data_ , ค่าตัวแปรดิบที่อ่านได้จากที่ server response กลับมา 

//Serial.println(rawData); // ลบ comment ออก ถ้าต้องการดูว่าค่าท่ี response กลับมามีอะไรบ้าง 

String dataSub = rawData.substring(rawData.indexOf("close")+9); //สร้างตัวแปรมาเพ่ือ substring 
เฉพาะข้อมูลที่เราต้องการใช้จริง ๆ 

 Serial.println(dataSub.length()); // ลบ comment ออก ถ้าต้องการดูขนาดข้อมูลหลังจากท่ีเรา 
substring จากข้อมูลทั้งหมดแล้ว 

 Serial.println(dataSub); //ลบ comment ออก ถ้าต้องการดูว่าข้อมูลที่เรา substring ออกมามีข้อมูลเป็น
อย่างไร 

 

*id_ = dataSub.substring(0,2).toInt();  // ท าการแปลงข้อมูลจาก String เป็น int ไปเก็บข้อมูลไว้ที่ตัวแปร 
pointer เพ่ือเปลี่ยนค่าให้กับตัวแปรที่เราอ้างอิง ก็คือตัวแปร lengthData นั่นเอง 

*data_ = dataSub.substring(3 , 3 + *id_).toInt(); // ท าการแปลงข้อมูลจาก String เป็น int ไปเก็บข้อมูล
ไว้ที่ตัวแปร pointer เพ่ือเปลี่ยนค่าให้กับตัวแปรที่เราอ้างอิง ก็คือตัวแปร data 

data=dataSub.substring(0,1).toInt(); 
} 

เป็นการ get ค่าจาก Server โดยส่ง http request ขอดูในข้อมูลล่าสุดของ field 1 ถ้าส่ง request ถูกต้อง 
Server ก็จะส่ง http response กลับมาเป็นค่าท่ีเราต้องการ เมื่อได้ค่าท่ีต้องการแล้วก็ท าการ substring ก็คือตัด
เอาข้อความเอาเฉพาะที่จ าเป็นมาใช้งาน ตามที่อธิบายไว้แต่ละบรรทัดที่ส าคัญ 
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เมื่อเรา update ค่าเป็น 0 

 

ผลที่ได้จาก last ของ field 1 ก็จะเป็น 0 และ LED จะดับ 

 

เมื่อเรา update ค่าเป็น 1 

 

ผลที่ได้จาก last ของ field 1 ก็จะเป็น 1 และ LED จะดับ 
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NETPIE 

  “NETPIE แพลตฟอร์ม IoT เพ่ือนักพัฒนาและอุตสาหกรรมไทย” โดยทีมพัฒนาของ Nectec ซ่ึงเป็น
แพลตฟอร์มทางเลือกแรกของนักพัฒนาไทยที่เชื่อมอุปกรณ์และเครื่องมือต่าง ๆ หรือ The Internet of Things 
(IoT) ระยะแรกเน้นการสนับสนุนนักพัฒนาและอุตสาหกรรมขนาดย่อม)SMEs) เพ่ือสร้างขดีความสามารถและ
ความเข้มแข็งให้กับอุตสาหกรรมไทยขนาดใหญ่ของไทย ซึ่งเป็น Platform ที่เราสามารถใช้ฟรีถึง 100 อุปกรณ์ต่อ 
Account และ Server อยู่ที่เมืองไทยมาลองเล่น NetPIE ไทยท า ไทยใช้ กัน 

 

Download Microgear https://github.com/netpieio/microgear-esp8266-arduino 

จะได้เป็น zip file ออกมาให้เรากินสะตอเข้าไปใน library  
 
ก่อนเริ่มเราต้องสมัคร NETPIE ก่อน 
  การสร้าง Application (แอพพลิเคชั่น  )เป็นตั วแทนของระบบของเรา (เช่น "ระบบสมาร์ทโฮมในบ้าน)"  
ในระบบของเราก็จะสามารถ เพ่ิมอุปกรณ์เข้าไปได้ โดยอุปกรณ์ของเรานั้นจะถูกเรียกว่า "Gear" (ปัจจุบันใช้ค าว่า 
Things) ซึ่งอุปกรณ์ท่ีว่านั้นก็อย่างเช่น ตัว NodeMCU ที่เราก าลังจะท าเป็นตัวควบคุมสวิชต์ไฟ หรือพวกบอร์ด
อ่ืนๆที่มีการต่อเซนเซอร์ส าหรับส่งข้อมูลค่าต่างๆ เช่นอุณหภูมิและความชื้น เป็นต้น ใน  Application หนึ่งอาจจะ
มีหลายๆ อุปกรณ์ (หลายๆ Gear ก็ได้  )และแต่ละ Gear ภายในระบบเดียวกัน  (ภายใน Application เดียวกัน  )ก็
จะสามารถสื่อสารกันเองระหว่างอุปกรณ์ได้ 

https://github.com/netpieio/microgear-esp8266-arduino
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  และแต่ละอุปกรณ ์ (แต่ละ Gear) ก็จะมี Key เป็นของตัวเอง ซึ่ง Key นี้ก็จะเป็นเหมือนสิ่งที่ใช้ระบุตัวตน
ของอุปกรณ์เรา (คล้ายๆกับเลขบัตรประจ าตัวประชาชน) แต่ละ Gear ก็จะมี Key เป็นของตัวเอง และก็จะไม่
เหมือนกับของ Gear อ่ืนๆ  

 
เมื่อเข้ามาใน Application แล้ว ท าการสร้าง Application เช่น MaxSmartHome 

 
จากนั้นก็จะปรากฏหน้าต่างส าหรับการสร้าง Key ขึ้นมา ก็ให้ท าการตั้งชื่อให้อุปกรณ์ของเรา เช่น ตั้งชื่อเป็น 
SmartNode1 (ประมาณว่ากล่องสวิชต์เปิดปิดไฟของเราชื่อ SmartNode ตัวที่ 1) แล้วก็ท าการเลือก Type ให้
เป็น Session Key จากนั้นก็กด CREATE เลยครับ 
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ทีนี้ก็ให้กดที่ Key ที่สร้างไว้ ก็จะปรากฏข้อมูล Key ขึ้นมาหากจะเปลี่ยนชื่อของอุปกรณ์ ก็พิมพ์ชื่อใหม่ด้านบน 
แล้วก็กดปุ่ม RENAME 

 
ข้อมูลที่เราจะน าไปใช้ก็จะมี Key กับ SecretKey  
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LAB18: เปิดปิดไฟด้วย NETPIE ผ่านเว็บ HTML5 

Code NodeMCU 

LAB18: HTML5 Control by NETPIE 

#include <AuthClient.h> 
#include <MicroGear.h> 
#include <MQTTClient.h> 
#include <SHA1.h> 
#include <Arduino.h> 
#include <ESP8266WiFi.h> 
#include <EEPROM.h> 
const char* ssid     = "BUAKAEW_AP01"; 
const char* password = "BuaKaew159357"; 
#define APPID       "MaxSmartHome" 
#define GEARKEY     "l9kQv3Qhj8khNga" 
#define GEARSECRET  "Pv9nPFA87hnHuIKqgkq2fvB16" 
#define SCOPE       "MaxPlug1" 
WiFiClient client; 
AuthClient *authclient; 
int relayPin = D4; 
MicroGear microgear(client); 
void onMsghandler(char *topic, uint8_t* msg, unsigned int msglen) { 
  Serial.print("Incoming message --> "); 
  Serial.print(topic); 
  Serial.print(" : "); 
  char strState[msglen]; 
  for (int i = 0; i < msglen; i++) { 
    strState[i] = (char)msg[i]; 
    Serial.print((char)msg[i]); 
  } 
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  Serial.println(); 
  String stateStr = String(strState).substring(0, msglen); 
  if (stateStr == "ON") { 
    digitalWrite(relayPin, LOW); 
    microgear.chat("controllerplug", "ON"); 
  } else if (stateStr == "OFF") { 
    digitalWrite(relayPin, HIGH); 
    microgear.chat("controllerplug", "OFF"); 
  } 
} 
void onConnected(char *attribute, uint8_t* msg, unsigned int msglen) { 
  Serial.println("Connected to NETPIE..."); 
  microgear.setName("pieplug"); 
} 
void setup() { 
  Serial.begin(115200); 
  Serial.println("Starting..."); 
  pinMode(relayPin, OUTPUT); 
  microgear.on(MESSAGE,onMsghandler); 
  microgear.on(CONNECTED,onConnected); 
 
  if (WiFi.begin(ssid, password)) { 
    while (WiFi.status() != WL_CONNECTED) { 
      delay(500); 
      Serial.print("."); 
    } 
    Serial.println("WiFi connected"); 
    Serial.println("IP address: "); 
    Serial.println(WiFi.localIP()); 
    //uncomment the line below if you want to reset token --> 
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    microgear.resetToken(); 
    microgear.init(GEARKEY, GEARSECRET, SCOPE); 
    microgear.connect(APPID); 
  } 
} 
 
void loop() { 
  if (microgear.connected()) { 
    microgear.loop(); 
    Serial.println("connect..."); 
  } else { 
    Serial.println("connection lost, reconnect..."); 
    microgear.connect(APPID); 
  } 
  delay(1000); 
} 

หลังจากท่ี NodeMCU Connect กับ NETPIE แล้ว จะมี Key ขึ้นในหน้าของ Application 

 
ในส่วนของ HTML5 แก้ไฟล์ smartplug.html แล้วก็ท าการเอา KEY กับ SECRET และ APP ID ที่เราไปสร้างไว้
ใน NETPIE มาใส่ลงไป 
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เสร็จแล้วก็กด File > Save เลยครับ 
ที่ส าคัญคือ นั่นคือ Microgear Library (ของฝั่ง HTML 5) ซึ่งไฟล์นี้จะต้องแยกมาดาวน์โหลดในภายหลัง เนื่องจาก
ทาง NECTEC จะมีการพัฒนาและแก้ไขปรับปรุง Library นี้อยู่เรื่อยๆก็ให้ท าการ Download ไฟล์ Microgear 
Library ส าหรับ HTML5 จากลิ้งค์ด้านล่างนี้ มาลงไว้ในโฟล์เดอร์ที่มีไฟล์ HTML  
https://github.com/netpieio/microgear-html5  
ผลที่ได้ คือ สามารถเปิดปิดไฟบน Web โดยผ่าน NetPie 

 

 

https://github.com/netpieio/microgear-html5
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LAB19: NETPIE Freeboard 
  Freeboard นั้นเป็น Web Application ที่ท าให้เราสามารถสร้าง Dashboard (แดชบอร์ด  )ส าหรับ
ระบบ IoT ของเราขึ้นมาได้ ถ้าจะให้พูดง่ายๆ ก็คือคล้ายๆกับการสร้าง กระดาน IoT ส่วนตัวที่เราสามารถวาง

ปุ่มกด,สวิชต์ ไว้ใช้ส าหรับควบคุมอุปกรณ์ หรือวางหน้าปัดไว้ส าหรับแสดงผลข้อมูลต่างๆที่ได้จากอุปกรณ์ในระบบ 
IoT ของเรา นอกจากนี้ยังสามารถน าข้อมูลที่ได้มาไปแสดงผลเป็นกราฟและสามารถปรับแต่งได้ตามใจชอบได้ง่ายๆ 
เพียงแค่ คลิ๊ก -ลาก-วาง และมีการป้อนข้อมูลหรือค าสั่งอีกนิดหน่อย  ก็สามารถท างานได้แล้วครับคือง่ายมากๆ ไม่
ต้องเสียเวลานั่งงมเขียนเป็น HTML Webpage ให้วุ่นวาย ที่ส าคัญคือข้อมูลนั้นมีการอัพเดทแบบ real-time มี
ความเสถียรและเชื่อถือได้ และเป็น Open-Source ซึ่งท าให้นักพัฒนาสามารถต่อยอดให้ดียิ่งขึ้นได้อีกด้วย 
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STEP1: ดาวน์โหลดและติดตั้ง NETPIE Freeboard 
   ส าหรับตัว NETPIE Freeboard (และ Freeboard อ่ืนๆ  )นั้นจะมีระบบไฟล์แบบเดียวกับเว็บเพจต่างๆ  

คือจะมีไฟล์ค่อนข้างเยอะหน่อย แต่ถูกจัดเก็บไว้อย่างเป็นระบบในโฟล์เดอร์ต่างๆ ซึ่งไฟล์ส่วนใหญ่นั้นก็จะ
ประกอบด้วยไฟล์เว็บเพจที่เป็น html และไฟล์โค้ด Javascript ต่างๆ  โดยไฟล์ทั้งหมดทีมงาน NETPIE ได้อัพขึ้น
ไว้ที่ Github สามารถเข้าไปดาวน์โหลดได้ตามลิ้งค์ด้านล่างนี้เลย 
 
https://github.com/netpieio/netpie-freeboard 
 
STEP2: ท าความเข้าใจกับ Freeboard Datasource 
      เนื่องจาก NETPIE Freeboard นั้นจะเป็นหน้าเพจที่แสดงข้อมูลต่างๆ ซึ่งตัวอุปกรณ์ (Things) ของเรา
ภายใน AppID เดียวกันนั้นจะมีการ chat เพ่ือส่งข้อมูล (เช่นค่าอุณหภูมิ/ค่าต่างๆจากเซนเซอร์) หรือส่งค าสั่ง 

(เปิด/ปิด )หากัน และกัน ซึ่งตัว Freeboard เองก็ต้องท าตัวให้เปรียบเสมือนว่าเป็น Things ตัวหนึ่ง ที่ Things 
อ่ืนๆ สามารถ chat ส่งข้อมูลมาหาได้เช่นกัน เพ่ือที่จะได้น าข้อมูลเหล่านั้นมาแสดงผลบน Dashboard ของเรา
ตามท่ีเราต้องการได้ ซึ่งเราจะต้องสร้าง Datasource ขึ้นมา เพื่อเป็นตัวกลางของการสื่อสารรับส่งข้อมูล (เป็น
ตัวแทนของ Freeboard) ซึ่งส าหรับคนที่ใช้ NETPIE อยู่แล้ว ก็สามารถสร้าง Datasource แบบ NETPIE 

Microgear ได้เลย (โดยใช้ Key จาก NETPIE) หรือส าหรับใครที่ใช้งาน Datasource แบบอื่นก็สามารถเพ่ิมได้เช่น
กับ โดย NETPIE Freeboard นั้นรองรับ Datasource หลากหลายรูปแบบเลย ทั้ง JSON, Open Weather 
Map, Dweet.io, Playback, Clock และ Octoblue  แต่ในที่นี้ผมจะขอพูดถึง Datasource แบบของ NETPIE 
Microgear  

 

https://github.com/netpieio/netpie-freeboard
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  ซึ่งในการเพ่ิม Datasource แบบ NETPIE Microgear นั้น ให้ท าการสร้าง Key ใหม่ขึ้นมาใหม่ใน AppID 
ที่เราต้องการให้ Freeboard แสดงผลและรับส่งข้อมูล (AppID ที่มี Things อ่ืนๆอยู่ด้วย  )เพ่ือน า Key และ 
Secret ไปใส่ใน Freeboard 
 
สร้าง Gear ของ Datasource 

 
บันทึกค่า Key เก็บไว้ 

 
เปิดไฟล์ index.html เลือก add datasource 

 
ก็ให้น าข้อมูลจาก Key ส าหรับ Datasource ที่เราสร้างไว้ใน NETPIE มากรอกลงไปและท าการตั้งชื่อ Device 
Alias และ Microgear Reference ไว้ใช้กับค าสั่งต่างๆด้วย (Device Alias จะใช้เป็นเหมือนชื่อเรียกเวลาเรา
ต้องการ chat ไปหา Datasource ผ่านค าสั่งต่างๆ ส่วน Microgear Reference เป็นชื่ออ้างอิง Microgear ครับ 
เพราะ Datasource จะท าตัวเหมือนกับว่าเป็น Things หนึ่งๆ (ท าตัวเป็น Microgear ตัวหนึ่งแต่ไม่ได้มีตัวตนจับ
ต้องได้จริงๆ) ซึ่งเป็นชื่อที่ Freeboard จะใช้อ้างถึงตัวเอง เวลาจะค าสั่งส่งข้อความหนึ่งๆ โดยจะมีรูปแบบนี้ 
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microgear["ชื่อ Microgear Reference"].chat("ชื่อผู้รับ)Alias)","ข้อความ"( 
เช่น ผมต้องการใช้ Freeboard ของผม ซึ่งกรอกข้อมูลทุกอย่างดังรูปที่ผ่านมาไปสั่งเปิดไฟหน้าบ้านของ โดยที่ชุด
เปิดปิดไฟของผมมี Alias เป็น smartnode1 ก็จะใช้ค าสั่งนี้บน Freeboard  
microgear["freeboard_mg1"].chat("smartnode1","ON") 

และเม่ือกรอกข้อมูลเรียบร้อยแล้ว ก็ให้กด Save ด้านล่างเลย 

 
หลังจากนั้นเราก็จะเห็น Datasource ที่เราสร้างข้ึนปรากฏในรายชื่อ Datasource ใน Freeboard หนึ่งจะใช้
หลายๆ Datasource ก็ได้ ไม่ได้จ ากัดว่าต้องใช้แค่ Datasource เดียวโดยหลังชื่อ Datasource จะแสดงข้อมูล 
Last Updated ซึ่งจะแสดงเวลาที่มีการอัพเดทข้อมูลล่าสุด (ในตอนนี้ Datasource ของเรายังไม่มีการรับส่ง chat 
ครับเลยยังเป็น never อยู่) และจะมีปุ่ม Refresh ไว้ส าหรับรีข้อมูลใหม่ และปุ่มถังขยะไว้ส าหรับลบ Datasource 
นี้ทิ้งไป 
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LAB20: เปิดปิดไฟผ่าน NETPIE Freeboard 
ท าการสร้าง KEY ชื่อ TestLED ไว้ใน NETPIE และท าการน ามาใส่ค่าในส่วนที่ผมคอมเมนต์ไว้ (7 บรรทัดนั้น  )ให้
ถูกต้องจากนั้นก็โหลดโค้ดลงบนบอร์ดได้เลย 
LAB20: ON/OFF by NETPIE Freeboard 
#include <AuthClient.h> 
#include <MicroGear.h> 
#include <MQTTClient.h> 
#include <SHA1.h> 
#include <Arduino.h> 
#include <ESP8266WiFi.h> 
#include <EEPROM.h> 
 
const char* ssid     = "BUAKAEW_AP01";      //== 1 == ใส่ชื่อเครือข่าย WiFi ที่จะให้ NodeMCU V2 
เชื่อมต่อ 
const char* password = "BuaKaew159357";            //== 2 == ใส่รหสัผ่านของเครือข่าย WiFi ที่จะให้ 
NodeMCU V2 เชื่อมต่อ 
#define LEDPin D4                                 //== 3 == หากต่อหลอด LED ที่ขาอ่ืนที่ไม่ใช่ D2 ให้ท าการ
เปลี่ยนชื่อขาตรงนี้ด้วย 
#define APPID       "MaxSmartHome"              //== 4 == ใส่ Application ID (ชื่อ Application) ที่
สร้างบน NETPIE 
#define GEARKEY     "l9kQv3Qhj8khNga"             //== 5 == ใส่ Key ของอุปกรณ์ ที่ได้จากการสร้าง
บน NETPIE 
#define GEARSECRET  "Pv9nPFA87hnHuIKqgkq2fvB16"   //== 6 == ใส ่Secret ของอุปกรณ์ ที่ได้จาก
การสร้างบน NETPIE 
#define ALIAS       "testled"                     //== 7 == ตั้งชื่อ Alias ให้กับ Things นี้ (เป็นชื่อเรียกเวลา 
chat มาหา) 
#define SCOPE       "" 
WiFiClient client; 
AuthClient *authclient; 
MicroGear microgear(client); 
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void onConnected(char *attribute, uint8_t* msg, unsigned int msglen) { 
  Serial.println("Connected to NETPIE..."); 
  microgear.setAlias(ALIAS);                  
} 
void onMsghandler(char *topic, uint8_t* msg, unsigned int msglen) { 
  Serial.print("Incoming message --> "); 
  Serial.print(topic); 
  Serial.print(" : "); 
  char strState[msglen]; 
  for (int i = 0; i < msglen; i++)   { 
    strState[i] = (char)msg[i]; 
    Serial.print((char)msg[i]); 
  } 
  Serial.println(); 
  String stateStr = String(strState).substring(0, msglen); 
//=========== ช่วงประมวลผลค าสั่ง ============= 
  if (stateStr == "ON")   { 
    digitalWrite(LEDPin, HIGH); 
    microgear.chat("testledstatus", "ON");        //==== ค าสั่ง chat เพ่ือบอกส่งค่าสถานะไปยังหลอด 
LED บน NETPIE Freeboard 
  }  
  else if (stateStr == "OFF")   { 
    digitalWrite(LEDPin, LOW); 
    microgear.chat("testledstatus", "OFF");       //==== ค าสั่ง chat เพ่ือบอกส่งค่าสถานะไปยังหลอด 
LED บน NETPIE Freeboard 
  } 
//=========== ช่วงประมวลผลค าสั่ง  ============= 
} 
void setup()  
{ 
  Serial.begin(115200); 
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  Serial.println("Starting..."); 
  pinMode(LEDPin, OUTPUT); 
  microgear.on(MESSAGE,onMsghandler); 
  microgear.on(CONNECTED,onConnected); 
  if (WiFi.begin(ssid, password))   { 
    while (WiFi.status() != WL_CONNECTED)     { 
      delay(500); 
      Serial.print("."); 
    } 
    Serial.println("WiFi connected"); 
    Serial.println("IP address: "); 
    Serial.println(WiFi.localIP()); 
    //uncomment the line below if you want to reset token --> 
    microgear.resetToken(); 
    microgear.init(GEARKEY, GEARSECRET, SCOPE); 
    microgear.connect(APPID); 
  } 
} 
void loop() { 
  if (microgear.connected())   { 
    microgear.loop(); 
    Serial.println("connect..."); 
  }  
  else   { 
    Serial.println("connection lost, reconnect..."); 
    microgear.connect(APPID); 
  } 
  delay(1000); 
} 

เมื่ออัพโหลดลงแล้ว ก็ให้ลองเปิด Serial Monitor (เลือก Baud Rate เป็น 115200) ดูว่าบอร์ดของเรานั้น
เชื่อมต่อเรียบร้อยหรือไม่ ตามรูปด้านล่างนี้ 
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ถ้าหากไม่มีปัญหาอะไรแล้วก็เป็นอันว่าเรียบร้อย เพียงเท่านี้เราก็จะได้ Thing ที่มีหลอด LED หนึ่งหลอด และ
พร้อมที่จะทดลองการเปิดปิดผ่าน NETPIE Freeboard แล้ว 
ในส่วนของ Freeboard ให้ท าการเปิด Freeboard ที่เราสร้าง Datasource ไว้ใน Part แรกข้ึนมาจากนั้นก็ให้กด
ปุ่ม ADD PANE ตามภาพนี้ 

 
สร้าง Widget เป็นปุ่มเปิดปิด 
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โดยค่าต่าง ๆ ได้จาก 
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เราสามารถควบคุมการเปิดปิดไฟด้วยปุ่มบน Freeboard ได้ 

 
 
Widget ที่น่าสนใจอีกตัวคือ Toogle  

 
มีการก าหนดค่าตามนี้ 
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Widget ที่น่าสนใจอีกตัวคือ Text 

 
มีการก าหนดค่าตามนี้ 

  
 
Widget ที่น่าสนใจอีกตัวคือ Indicator Light 
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LAB21: วัดอุณหภมูิ ความชื้น ส่งค่ามาแสดงบนฟรีบอร์ด 
 
  หลังจาก Part ที่แล้วเราได้ลองเปิดปิดหลอดไฟ (LED) ผ่าน NETPIE กันแล้ว ซึ่งนั่นเป็นรูปแบบของการส่ง
ข้อมูลสถานะ "เปิด "หรือ "ปิด "ระหว่าง Freeboard ของเรากับอุปกรณ์ (Things) นั้น คาดว่าหลังจากได้ทดลอง
ลงมือท าดูจริงๆแล้วคงท าให้เข้าใจระบบการท างาน ของ NETPIE Freeboardกันมากข้ึนแล้ว และใน Part นี้จะ
เป็นการทดลอง ส่งค่า "อุณหภูมิ "และ "ความชื้น " มาแสดงบน Freeboard ขอเรียกการทดลองนี้ว่า 
"SmartSensor" 
  ก่อนอ่ืนก็ให้สร้าง Key ส าหรับอุปกรณ์นี้บน NETPIE ก่อนเช่นของผมสร้างไว้ภายใน AppID ชื่อ 
MaxSmartHome โดยสร้างเป็น Device Key ชื่อว่า SmartSensor  
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LAB21: NETPIE Freeboard Read From Sensor DHT11 
#include "DHT.h" 
#include <AuthClient.h> 
#include <MicroGear.h> 
#include <MQTTClient.h> 
#include <SHA1.h> 
#include <Arduino.h> 
#include <ESP8266WiFi.h> 
#include <ESP8266WebServer.h> 
#include <ESP8266mDNS.h> 
#include <EEPROM.h> 
 
const char* ssid     = "BUAKAEW_AP01";   //ชื่อ SSID ของ WiFi ที่จะเชื่อมต่อ 
const char* password = "BuaKaew159357";           //รหัสผ่านของ WiFi ที่จะเชื่อมต่อ 
 
#define APPID   "MaxSmartHome"               //ใส่ APPID ที่สร้างไว้ใน NETPIE 
#define KEY     "8UqxbpczvuU25WK"              //ใส่ KEY ที่สร้างไว้ส าหรับ SmartSensor 
#define SECRET  "C0bbEbmZiGbDLCDgE578tBS9C"    //ใส่ SECRET ของ KEY ที่สร้างไว้ 
#define ALIAS   "SmartSensor"                  //ตั้งชื่อให้กับอุปกรณ์นี้ (เช่นตอนนี้ผมตั้งชื่อว่า )
"SmartSensor" 
#define DHTPIN  D5           //ระบุขาที่ต่อกับเซนเซอร์ DHT 
#define DHTTYPE   DHT11      //ระบุว่าใช้ DHT11 หรือ DHT22 (ในที่นี้ผมใช้เป็น DHT22) 
#define RefreshTime   100    //ค่าความถ่ีของการส่งข้อมูล เช่นในที่นี้คือ ส่งข้อมูลออกไปทุกๆ 0.1 วินาที 
(100 ms) 
WiFiClient client; 
AuthClient *authclient; 
 
DHT dht(DHTPIN, DHTTYPE);   
int timer = 0; 
MicroGear microgear(client); 
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void onConnected(char *attribute, uint8_t* msg, unsigned int msglen)  
{ 
  Serial.println("Connected to NETPIE...");     //หากการเชื่อมต่อส าเร็จ ให้แสดงข้อความนี้ทาง Serial 
Monitor 
} 
 
void setup()  
{ 
  Serial.begin(115200); 
  Serial.println("Starting..."); 
  dht.begin();   
  microgear.on(CONNECTED,onConnected); 
  microgear.init(KEY,SECRET,ALIAS); 
  microgear.connect(APPID); 
 
  if (WiFi.begin(ssid, password))  
  { 
    while (WiFi.status() != WL_CONNECTED) 
    { 
      delay(500); 
      Serial.print("."); 
    } 
    Serial.println("WiFi connected"); 
    Serial.println("IP address: "); 
    Serial.println(WiFi.localIP()); 
  } 
} 
 
void loop()  
{ 
    if (microgear.connected())  
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    { 
      microgear.loop(); 
      timer=0; 
      float tempread = dht.readTemperature();   //เก็บค่าอุณหภูมิที่อ่านได้ไว้เป็นแบบ float ไว้ในตัว
แปร "tempread" 
      float humidread = dht.readHumidity();     //เก็บค่าความชื้นที่อ่านได้ไว้เป็นแบบ float ไว้ในตัวแปร 
"humidread" 
      char temp[10];     // 
      char humid[10];    // สร้างตัวแปรไว้ใช้ส่งข้อมูลทาง microgear.chat (ต้องใช้รูปแบบ char) 
      if (isnan(tempread) || isnan(humidread) || tempread > 100 || humidread > 100)     { 
          tempread = 0.0;       // ถ้าอ่านค่าไม่ได้ หรืออ่านค่าได้มากกว่า 100 
          humidread = 0.0;      // ให้แสดงค่าเป็น 0 แทน 
      } 
       
      int tempread_decimal = (tempread - (int)tempread) * 100;      // เก็บส่วนของตัวเลขท่ีอยู่หลัง
จุดทศนิยม ไปเป็นแบบ int 
      int humidread_decimal = (humidread - (int)humidread) * 100;   // เช่น 35.87 จะเก็บ 87 ไว้ใน
ตัวแปร 
 
      sprintf(temp,"%d.%d", (int)tempread,tempread_decimal);      // ยัดค่าตัวแปร int เข้าไปในตัว
แปร char โดยมีรูปแบบ 
      sprintf(humid,"%d.%d", (int)humidread,humidread_decimal);   // %d.%d = ส่วนจ านวนเต็ม.

ส่วนทศนิยม (จะ chat ตัวแปรนี้ไป) 
      Serial.print("temp = "); 
      Serial.print(temp); 
      Serial.print(" Hum = "); 
      Serial.println(humid); 
      microgear.chat("SmartSensor/Temperature",temp);     // ท าการ chat ตัวแปรต่างๆ ออกไป 
      microgear.chat("SmartSensor/Humidity",humid);       // โดยใช้ชื่อผู้รับเป็น 
"SmartSensor/Temp,Humid,LightLevel" 
    } 
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    else 
    { 
      Serial.println("connection lost, reconnect..."); 
      microgear.connect(APPID); 
      delay(timer); 
      timer+=100; 
    } 
    delay(RefreshTime);   // รอเวลาเป็นจ านวนเท่ากับที่ตั้งไว้ในตัวแปร RefreshTime 
} 

แสดงผลดังรูป Serial 

 
 
ในส่วนของ Freeboard เร้า Add Widget Gauge 

 
ในส่วนของ Datasource ก าหนดเป็น 
datasources["Datasource"]["/MaxSmartHome/gearname/SmartSensor/Temperature"] 
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และ Humidity เช่นกัน 

 
 
 

LAB: เขียนโปรแกรมควบคุมผ่านมือถือด้วย APP Inventor 
 

 

LAB: Facebook BOT API chat NETPIE IoT 
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